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Tuesday, August 4, 2009 
Holiday Inn ~ The Shawnee Room 

8787 Reeder Rd, Overland Park, KS 66214 
(Near 87th and Alternate 69 Hwy, just east of I35) 

 
 

Presentation: 
“Diversity Training – Commitment to  

Mutual Courtesy and Respect” 
 

Training of Chapter Bylaws Article X 
 

Presented By:  
Kimberly Roe, MBA, CB, SPHR 

 
 

Menu:  
Chicken Parmesan – Breaded Chicken Breast sautéed and 

topped with a rich Marinara sauce and Mozzarella cheese. Served 
over Penne pasta.  

 
Served with Caesar Salad, freshly baked bread and herbed butter, 

and dessert. 
 

Includes Iced Tea, Water and Coffee. 
 
 

Please RSVP no later than noon on July 30 to: 
donna.r.degarmo@sprint.com 

 
NOTE: If you RSVP and cannot attend and cannot get someone to 
take your  place, you will receive an invoice for the $20 meeting fee  

                                                                                                                                                    July 2009 

mailto:donna.r.degarmo@sprint.com�


-2- 

 

August 2009 

Greetings to everyone, 
  
Can you actually believe it is almost August already? With a blink of an eye, the summer is a memory. 
  
As we begin our year, we will need to share the great opportunities that the IAAP has to offer with our colleagues, 
our friends and to those new acquaintances we have yet to meet. Our goals and objectives for the new year are 
simple; 
  

1)      Grow the chapter 
2)      Retain our members 
3)      Build best practices 
4)      Become a Chapter of Excellence 
5)      Have Fun 

  
We have so many opportunities coming up in the weeks ahead. Leadership Bootcamp on August 22 in Topeka, 
Kansas Division Fall Workshop on October 3 in Wichita and our fall mock exam on October 24. Having just 
attained my two certification designations and becoming president of this chapter, I am very excited about the many 
opportunities that this chapter has to offer. I hope that each of you will begin making plans to become certified and 
growing professionally. We each need to take the reins of our own career, ask for help in areas that we need it and 
most importantly have fun doing it. 
  
As the months unfold, the board will be addressing each of the above objectives, 
sharing with you our progress towards them and will continually ask for your input so 
that we all share in the same common goals.  Get R Done! 
  
Many of you may not know a lot about each of your board members, so look for the 
bio’s included in this publication.  We hope this will assist with any questions that 
you have, and will tell you a little about our backgrounds. 
  
I wish each of you good luck this new chapter year, and I hope to see as many of you 
as possible attending the Leadership Bootcamp on August 22. 
  

Michele Bohnen CPS/CAP 
Chapter President 
 

P R E S I D E N T ’ S  L E T T E R … 
M I C H E L E  B O H N E N  CPS/CAP 

   
 

J O H N S O N  C O U N T Y  C H A P T E R  O F  I A A P  
2 0 0 9 - 2 0 1 0  B OA R D  O F  D I R E C T O R S  
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The 2009-2010 Board during the business portion of the July Chapter meeting. From left to right: 
Ceci Cook, Treasarer; Pat Greener CPS/CAP, Secretary; Donna DeGarma CPS, VicePresident;  
Michele Bohnen CPS/CAP, President; Bonnie Jameson CPS/CAP, Parlimentarian 
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“Executive Night & Awards Dinner”  

 
“What IAAP Can Do For Your Business”  
Presented By Past IAAP International President, Kay Enlow   

 
Kay gave a very informative presentation about 
the history of the certification program, the details 
of the programs, the benefits for both the 
administrative professional and their executives, 
and tips for preparing for the exams. Attendees 
also enjoyed the inspiring talk Kay gave about her 
own journey in 
becoming 
certified. 
 
 
 
 
 

 
Kay Enlow CPS/CAP, Past International President with 
Michele Bohnen CPS/CAP, newly installed Johnson 
County Chapter President 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Johnson County Chapter Executive of the Year,   Last year recipient, Ralph Beacham Ph.D. with 
Brad xxx with Executive Assistant Mary Miller CPS  Administrative Assistant, Carol Zamaitis 
 

J U N E  M E E T I N G   
U P DA T E  
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Getting to know the Johnson County Chapter 2009‐2010 Board 
 
President Michele Bohnen CPS/CAP: 
 
  Michele Bohnen works as an Executive Administrative Assistant at Sprint Corporation in Over‐
land Park, Kansas. Michele has worked for Sprint for the past 10 years in Advanced Technology Develop‐
ment, Technology Services and now Product Development. 
  While at Sprint, Michele has chaired several community relations teams, and each year her team 
winning the coveted “Spirit Award,” in which the team was given $250 ‐ $500 each year to give to a char‐
ity of the their choice. She also is the co‐lead for the Sprint Administrative Professional Community of 
Practice (APCoP) and has lead several initiatives; including topics as Mentoring, IAAP Certification and 
is the webmaster of the Answer Place Intranet website. 
  Prior to working at Sprint, Michele was in the medical field for 18 years serving as a surgical 
scheduler for six cardiovascular surgeons. Michele was responsible for keeping the surgical team of six 
surgeons, six physician assistants and three surgical technicians busy in the OR of three local hospitals 
in Evansville, Indiana. 
  In her spare time, Michele has served on the board of her neighborhood homes association. As 
Pool Committee Chair, Michele was response for preparing budgets, supervising personnel and present‐
ing monthly and year‐end reports to both the board and the homeowners at annual meeting. 
  Michele holds an Associate of Arts ~ Liberal Arts degree from Johnson County Community Col‐
lege. She is a Certified Professional Secretary (CPS) and a Certified Administrative Professional (CAP) 
and is studying to take the Microsoft Certified Application Specialists (MCAS) exams for Microsoft Office 
applications. She is married and has a blended family of 5 teenage children; 4 boys and 1 girl, ranging in 
age from 14 to 20. 

 

Vice­President Donna DeGarma CPS: 

   
  Donna is the Executive Assistant to Sprint’s Senior VP of Network, responsible for planning, coor‐
dinating and execution of meetings and special events for the Network organization.  She provides ad‐
ministrative support, communication flow and manages process flows and special projects as assigned 
for the Network organization. 
In addition to her normal duties, Donna was instrumental in the development of a community of prac‐
tice for Sprint’s Administrative Professionals and serves as leader for the group.  This organization was 
founded in 2002 by a small group of Administrative Professionals and is responsible for the achieve‐
ment of many enterprise‐wide initiatives that have improved the productivity of Sprint Administrative 
Professionals and the enterprise as a whole. 
  In 2007 Donna was named first runner up for the National Administrative Professional of the 
year for Administrative Excellence.  She is also the recipient of three Sprint Achievement of Excellence 
awards. 
  Donna is also a member of IAAP ‐ International Association of Administrative Professionals and 
serves as Vice President of the Johnson County Chapter.   Donna received her CPS  designation (Certified 
Professional Secretary) in June 2009. 
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Meet the Johnson County Chapter 2009‐2010 Board (cont’d) 
 
Secretary Pat Greener CPS/CAP   

Pat grew up in the Midwest and has lived in Kentucky, Arizona, Colorado and now Missouri.  After graduating 
from the Mitchell Area Vocational‐Technical School in 1977, she began her long career in the administrative field 
for more than 25 years in every position from receptionist to Executive Assistant to the Senior Vice‐President.  As 
far as industries, she has been in the construction, financial, sales and now telecommunications industries.  She 
loves this field because it is so diverse.  Giving back to the Johnson County administrative professionals will be her 
focus for the remainder of her career.   

Treasurer Ceci Cook: 
 
  Ceci began her administrative career in the St. Louis, MO area right out of high school working as an office 
assistant for American Family Insurance until she had her first child. 
  After that she worked as a “Girl Friday” in a small business with just her providing all the office support 
from answering phones to being a full‐charge bookkeeper and everything in between.  She then moved on to a 
shoe manufacturing company where she was the ‘left hand’ of the Controller and broadened her accounting skills.  
From there she has worked for attorney’s, accounting firms, insurance agents and various companies in the health 
industry as an Executive/Personal Assistant and providing accounting duties in many.  
  She fulfilled a lifelong dream of becoming a nurse in her 40’s and had a very fulfilling career as a Chil‐
dren’s Psychiatric Nurse before coming back to the Executive Admin field.  
  She joined the International Association of Administrative Professionals in 2000 but was not an active 
member until she came to Kansas City in 2007 and joined the Johnson County Chapter.  
  Since Ceci became a member of the Johnson County Chapter she has been a member of several commit‐
tees; has served as Nomination Committee Chair and Co‐Chair; Education Seminar Chair; New Location Co‐Chair; 
KDAM 2010 Co‐Chair and is currently serving as Treasurer.  In 2008, she was honored to be named Member of 
the Year for the Johnson County Chapter.  In 2009, she was thrilled and privileged to be named Chapter Member 
of the Year for Kansas Division Professional Development.  
  Ceci is married and lives in Lenexa, Kansas with her husband, Rod, and their ‘baby’ Maggie.  When not in‐
volved with IAAP, and hard at work at Garmin, Ceci spends time doing various crafts, is part of a monthly Bunko 
group, loves to read and travels across the state several times a month to visit her and her husband’s family in the 
St. Charles/Belleville, IL.  Ceci has two children (boy and girl) and one step daughter along with three (3) grand‐
sons the oldest of which shares the same birthday as her. 
 
Parliamentarian Bonnie Jameson CPS/CAP: 

Bonnie began her administrative career while a high school senior where she was a member of the Office 
Education Association, attending administrative classes for four hours along with work experience received with 
JCPenney in their Regional Credit Office. 

Upon graduation, Bonnie continued with JCPenney for the next thirty two years, staying through the sale 
of the division and creation of a new company known as Alliance Data Systems.  Before leaving Alliance Data in 
December 2006, she worked in both Customer Service and Collections as Statistical Specialist and Administrative 
Assistant.  Currently, Bonnie is Finance & Administrative Coordinator with the National Multiple Sclerosis Society 
Mid America Chapter. 

Bonnie has been a member of  IAAP since  July 2005 and received her CPS (Certified Professional Secre‐
tary) in May 2006 and her CAP (Certified Administrative Professional) in November 2006. 

She has served the Johnson County Chapter as Membership Chair, RTF chair, and is currently Parliamen‐
tarian.  In 2007, she was honored to be named Member of the Year for the Johnson County Chapter. 

Bonnie is single and lives in Kansas City, Kansas with her Papillon, Jazzie.  When not involved with IAAP, 
Bonnie likes to spend time with her three Godchildren and their children (ages 5, 3, and 4 months) and served as 
Bridal Assistant for her youngest Goddaughter at her June 2009 wedding.   
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Have you thought lately about how valuable your IAAP membership is to you? Here’s a list of benefits outlined 
by IAAP International Headquarters. 
 

Continuing Education and Training via: 
 Professional Education Conference 
 Certification Conference 
 OPTIONS Training Program 
 Opportunity to Earn Continuing Education Units (CEU) 
 Annual International Convention and Education Forum 
 Online Education Courses 
 Associate Degree Program 
 Annual Meetings 
 Chapter Meetings 
 Website Resources www.iaap-hq.org 
 OfficePro® Magazine 
 OfficePro® Express e-newsletter 
 Connections e-newsletter 
 Booklets and Self-Study Courses 

Professional Certification 
 Certified Professional Secretary® Program 
 Certified Administrative Professional® Program 

Networking Levels: 
 International 
 Division 
 Chapter/Local 

Recognition: 
 Administrative Professionals Day® / Week® 
 Recognition Plus Awards Program 

Support: 
 IAAP Vendors/Sponsors 
 IAAP World Headquarters Staff 
 International Board of Directors 
 District Directors 
 Division Officers 
 Chapter Officers 
 Peers 

 
Just think of all the education you receive at the monthly chapter and quarterly division meetings, and the 
networking you obtain at these events – this is a wonderful investment in your future. Our chapter is committed 
to helping its members obtain their CPS and CAP designations by providing workshops and study groups. (To 
learn more about how a CPS and/or CAP designation can count towards a college degree program at JCCC, see 
page 11 of this newsletter.) 
 
For only two, yes $2.00 a week, you can save for your yearly dues – that’s less than the cost of one large soda at 
a restaurant or one latte at the coffee shop! What are you going to do with your future? We hope you see that the 
investment in your IAAP membership is beneficial to your growth in your future.  Won’t you choose today to 
invest in you? 
 
 
Mary Miller CPS 
 

Invest in Your IAAP Membership 
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Don’t forget to bring a donation for the 

Safe Home  
 

 
 
 

and  
TLC For Children and Families  

 
 
 
 

to the next 
meeting.  

Just think of the difference  
we can make! 

 
For a listing of acceptable donation items for 
SAFEHOME and TLC For Children and 

Families, please visit their websites at 
www.safehome-ks.org and www.kidstlc.org. 

The Right Way to Take Time Off 

Everyone needs a chance to escape the demands of 
the office, and there is no better time than summer. 
In fact, more than half of managers polled by our 
company said July and August are ideal for staff 
vacations.  
 
Taking time off allows you to recharge your 
batteries and remain productive. Of course, many 
people find it challenging to step away from work. 
But avoiding at least occasional breaks can sap your 
motivation and lead to burnout.  
 
The following tips can help you get away without 
work-related worries: 
 

M ake a plan. Request time off as far in 
advance as possible. The sooner you 

notify your manager about your intent to 
take a vacation, the better your chances of 
securing the dates you want. 

 

C all for reinforcements. Identify 
coworkers who can keep projects 

moving while you are away. Also talk to 
your boss about designating a point person 
who can make decisions on your behalf on 
time-sensitive initiatives. Offer to return the 
favor when this person is out of the office. 

 

R edirect calls and e-mails. . Provide 
alternative contact information in your 

voice-mail and e-mail messages so that 
incoming requests can still be handled 
promptly. Also notify key contacts — both 
internal and external — in advance so they 
won’t be caught off guard and know who 
can address their needs while you are away. 

 

L eave it all behind. Regardless of whether 
you are staying in town or going away, 

you need to disconnect from the office. 
Unless your job demands it, avoid checking 
your e-mail and voice mail remotely. Also 
resist the temptation to bring projects with 
you.  

 

Advance planning can make all the difference in 
minimizing pre-vacation stress levels. You’ll find it 
easier to put your work concerns behind you and 
relax during your days off. 
 
 
Article Provided By OfficeTeam. 
OfficeTeam is the world's leading staffing service 
specializing in highly skilled administrative and 
office support professionals. The company has 
more than 300 locations worldwide, and offers 
online job search services at www.officeteam.com.  
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E-mail Mistakes That Make You Look Bad 
by Kim Komando for Microsoft.com  (article submitted by Johnson County IAAP Chapter Member Debbie Nash) 

For more help on running a small business, check out 
the Small Business Center. 
 
I get an awful lot of e-mail. Sometimes, people are 
looking for help with their computers. Some of it is fan 
mail. 
 
Other folks are mad about something I said or wrote. 
Add to this the barrage of press releases and an 
occasional blast from the past when a former classmate 
or ex-boss drops me a note. 
 
After facing this tidal wave of electronic words for 
several years, as well as owning my own business, I’ve 
developed some strong opinions about e-mail and 
correspondents. 
 
Here are eight easily avoidable mistakes you should 
know about to keep your image and inbox in tip-top 
shape. 
 
1. Failing to follow e-mail etiquette 
I believe in the old adage, “You catch more flies with 
honey than with vinegar.” There's no point in belaboring 
the etiquette issue. We all know we should be polite. But 
here are a few points to consider: 
 Don’t write when you’re angry. Wait 24 hours. 

Calm down. Be reasonable. Have someone else edit 
your e-mail. 

 Don’t use sarcasm. You may think you’re clever, 
but the recipient will be put off. 

 DON’T USE ALL UPPERCASE! That’s the e-mail 
equivalent of yelling. Your recipient won’t be 
appreciative. Go easy on the exclamation marks, 
too. Overuse dulls their effectiveness. 

 Use clear subject lines. That will help people decide 
whether to read the e-mail now or later. We’re all 
busy. Your correspondent will appreciate your 
thoughtfulness. 

 Keep it short. If your e-mail is more than two 
paragraphs, maybe you should use the telephone. 

 Change the subject line if you change the topic of a 
thread. 

 Unless the recipient has previously agreed, don’t 
forward poems, jokes, virus warnings and other 
things. You're just wasting valuable time and 
bandwidth. 

 
2. Thinking you are anonymous 
If you are sending nasty missives, you might think no 
one will be able to figure out that the e-mail came from 
you. After all, you set up a phony Web address. Think 

again. E-mail contains invisible information about the 
sender. 
 
That information is in the header. All major e-mail 
programs can display header information. Here’s how: 
 In Microsoft Outlook, double click the e-mail. 

Then click View > Options.  
 In Microsoft Outlook Express, click the e-mail. 

Then click File > Properties and select the Details 
tab.  

 In Eudora, double click the message. Then click the 
Blah Blah button.  

 In Netscape, click the message to open it. Then 
click View > Message Source to display the 
header. 

 
The sender’s revealing information is in the sections 
that begin with “Received:.” There may be several of 
these, depending on the number of computers the e-
mail traversed. The originating computer is in the 
bottom “Received:.” 
 
That section will have an Internet Protocol (IP) 
number, such as 124.213.45.11. It can be traced on a 
number of Web sites. I use InterNIC 
(www.internic.net). The number is probably assigned 
to the sender’s Internet service provider, rather than the 
sender. But the ISP will be able to identify the sender 
using that number. Remember the header if you’re 
tempted to send an anonymous e-mail. You may be less 
anonymous than you think. 
 
3. Sending e-mail to the wrong person 
Today's e-mail programs want to make it easy to send e
-mail. This means that when you start typing the 
address of a recipient to whom you have previously 
sent mail, the “To:” field may already be populated. Be 
careful. Always double-check the recipient is the 
intended one. 
 
In addition, if you’re writing something ugly about Joe 
Smith, you'll have Joe's name on your mind. Don’t 
send it to him. I once knew an intern at a newspaper 
who did just that. He didn’t like his supervisor and said 
so in graphic terms in an e-mail. Then he accidentally 
sent the e-mail to his supervisor. (The intern kept his 
position, but the atmosphere was cold, to say the least. 
And there was no job offer at summer's end.) 
 
4. Using one e-mail address for everything 
I have four different e-mail addresses: private, public, 

Continued on next page 
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E-mail Mistakes That Make You Look Bad (cont.) 
by Kim Komando for Microsoft.com  

one I use for online mailing lists, and another for when I 
go shopping online. These addresses attract mail for 
those specific areas. 
 
I can have as many as I want, because I host my own e-
mail server. But if you are using an Internet service 
provider, you still can do this. Most providers will give 
you a half-dozen e-mail accounts. You can also use 
addresses on the Web for personal accounts. Both 
Hotmail and Yahoo! are good. You can reach those 
accounts from anywhere, assuming you have Web 
access. 
 
5. Forgetting to check all of your e-mail accounts 
Checking all these accounts can be a chore, especially 
from home. So I use ePrompter (www.eprompter.com), 
which can check 16 different password-protected 
accounts. Best of all, ePrompter is free. There are other 
programs that will do this for a fee, including Active 
Email Monitor (www.emailmon.com). 
 
6. Clicking "Send" too fast 
Reread every e-mail before you send it! I actually get e-
mails from job applicants with misspellings and missing 
words. They all go to the same place: the garbage. This 
is a pet peeve. I'm not going to hire someone who is 
careless. 
 
Even if you’re not looking for a job, you want to be 
careful. People will judge you subconsciously on 
mistakes. No one is perfect. But you can catch 99% of 
these problems by rereading the text. 
 
And don’t depend on the spell-checker. It will catch 
misspellings. But if you use “four” instead of “for,” or 
“your” for “you're,” it won't tell you. It also is not likely 
to catch any missing words in a sentence that you 
inadvertently failed to include. So take a minute and 
reread your text. Don’t look like an ignoramus. 
 
7. Forgetting the attachment 
This seems obvious, but I can’t tell you how many times 
I’ve received an e-mail with a missing attachment. Since 
we all do it occasionally, it shouldn't be a huge deal.  
However, if you consistently make this mistake, people 
(perhaps important people) may think you’re losing your 
marbles. They might even hesitate to do business with 
you in the future. When you get ready to send your e-
mail, think: “What am I forgetting?” 
 
8. Using your ISP's domain and not your own 
Make your company look big. If you use a Web account 

or an ISP’s name for your business, you’re not going to 
look professional. You can buy a domain name 
separately for $20-$30 per year from a company such 
as VeriSign (www.netsol.com), or as part of a package 
from a Web hosting and e-mail service such as that 
offered by Microsoft Small Business. Assuming 
someone else hasn’t already grabbed it, you can have 
your company in the domain name. 
 
Let’s say you run The BoolaBoola Co. If you use an 
ISP's address, you would have something like 
JoeBoolaBoola@SomeISP.com. But if you buy your 
own domain name, it could be 
Joe@TheBoolaBoolaCo.com. That’s much more likely 
to impress your customers. 
 
E-mail is almost like talking. We use it so much that we 
don't really think about it. But there are rules and 
courtesies, just as there are with talking. And there are 
other considerations involved in communicating by 
written word only. 
 
Giving them some additional thought could make your 
e-mail experience more satisfying and your recipients 
much happier. 
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8:00 AM Think bright with energy-efficient lights. Consider switching those office lights you turn on in the morning to 
Energy Star®-qualified bulbs. These bulbs last up to 10 times longer and use about 75% less energy than regular 
light bulbs. 

9:00 AM Go green with supplies. Recycled copy paper, biodegradable pencils, and other earth-friendly office products 
can help your company make that commitment toward a more sustainable workplace. The Avery EcoFriendly line 
of labels which includes address labels, shipping labels, file folder labels and name badges, earned their name 
because both the label paper and package are recyclable as part of paper waste. Another eco-minded product is 
the Avery Recyclable Binder, made with 100% recycled chipboard. After use, the binder cover and rings can be 
separated and recycled. And with all our environmentally friendly line of products, you can trust in the same high 
quality you’ve come to rely on from Avery. 

10:00 AM Give paper cups a break. It’s time for a coffee break—but back off from using that paper or Styrofoam™ cup for 
your daily intake of joe. Give the planet a break, too, by using reusable mug instead. 

11:00 AM Cut back on copies. The average U.S. office worker goes through 10,000 sheets of copy paper a year, accord-
ing to the Sierra Club. Rather than printing out all those memos or presentation handouts, send out electronic 
copies or use recycled paper and double-side your printing 

12:00 PM Set up a recycling station. After having a nice lunch, do you throw your garbage away in a trash can? Make 
recycling a no-brainer by creating a recycling station. 

1:00 PM Ship with available resources. Reusing old boxes is an economical way to ship while cutting down on waste. 
With Avery EcoFriendly Shipping Labels customized with free Avery Templates, it’s easy to keep up your green 
commitment and still give your packages a neat, professional appearance. And when you need some packing 
material, consider using shredded paper. 

2:00 PM Say “no” to junk mail. We spend an average of eight months of our lives dealing with junk mail, according to 
eco-cycle.org. To lighten the load, contact the Direct Marketing Association and register with their mail preference 
service so you can control the amount of direct mail you receive. 

3:00 PM Go eco-tripping. We have many options for going in to work, such as car- and van-pooling, telecommuting and 
teleconferencing. Now there are more options when traveling on business, too. Hybrid vehicle rentals, environ-
mentally friendly hotels and “green” event planning options are just some of the eco-conscious choices available, 
reports Shivani Vora in the article “Business Travelers Go Green” on Forbes.com. 

4:00 PM Monitor your indoor environment. When the weather’s cold, keep blinds open to capture as much warmth from 
the sun as you can, advises energystar.gov. On hot days, draw the blinds shut. Also make sure building vents 
aren’t blocked and your computer has space around it so air can circulate and help you save energy. 

5:00 PM Good night, sleep tight. Don’t let the electric bill bite. Before you pack it in for the day, make sure you shut 
down the equipment. Even during the day, it’s a good idea to switch your computer, printer and other electronic 
equipment to a “power save” mode when not in use. 

For recycle centers in the Kansas City area, visit www.recyclespot.org. 

The Office Guide to Going Green  

Article by Avery, submitted by Johnson County IAAP chapter member, Susan Williamson 
 http://www.avery.com/avery/en_us/Projects-%26-Ideas/Ideas-for-Work/Filing-Organization-Storage/Articles/The-Office-Guide-to-

Going-Green.htm?cmp_ID=email-apr2009-primOther_GreenOfficeGuide 
 

Want to do more to help the environment? The workplace offers plenty of opportunities where you and your co-workers 
can make a difference. Here are some eco-tips on how to easily incorporate going green into your work day: 

 
When you and your co-workers support each other and make the effort to go greener, doing your part to help the 

environment will soon become second nature. Share these tips at your workplace, and inspire those around you to make 
a positive change. Going green isn’t just a passing trend, it can be a way of life.  
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JULY 
BIRTHDAYS 
Gloria Bowman – July 8 

Susan Williamson – July 15 
Janet Harp – July 18 

Julie D. Lawrence CPS/CAP – July 20 
Carol Zamaitis – July 20 

 

JULY 
ANNIVERSARIES 

Barbara L. Slagle CPS – July 1982 
Cherie P Kennedy – July 2004 

Bonnie Jameson CPS/CAP – July 2005 

2009-2010 Member of the Year Criteria Guidelines 

AUGUST 
BIRTHDAYS 

Karen Herrington CAP – August 1 
Celeste Kvetensky CPS – August 3 
Terry L. Torello CPS – August 17 
Michele Bohnen CPS – August 22 

 
 

AUGUST 
ANNIVERSARIES 

Julie D. Lawrence CPS/CAP – August 1997 
Carol Zamaitis – August 2001 
Maat Manyatta – August 2008 

Attend Three Division Events Points 

  Annual Meeting 2009, June 19 - 21 2009 20 Points 

  Leadership Bootcamp 15 Points 

  Fall Workshop 10 Points 

  Spring Workshop 10 Points 

Chair A Committee  25 Points Per Committee 

Actively Participated By Attending Chapter Meetings Points 

  Executive Night - extra credit 10 Points 

       Add an additional 10 if your executive attended 10 Points 

  Attended 12 meetings 25 Points 

  Attended 10 meetings 15 Points 

  Attended 8 meetings 10 Points 

  Attended 6 meetings 5 Points 

  Attended less than 6 3 Points 

Participated In  JOCO Workshops/Training Events 20 Points Per Event  

Participated In Fundraising Activities 5 Points Per Event 

Participated On A Committee 10 Points Per Committee 

Brought Guests To Meetings 5 Points For Each Different Guest Brought) 

Community Service Opportunities 
5 Points Per Participation - IAAP/Work Re-

lated 

Extra Credit 
50 Additional Points For Sponsoring a New 

Member 
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Chapter and Division Certification Chairs, you have done an awesome job in this Excellence in Action year getting 
information out about the IAAP certification programs.  Thank you for a Great Job!! 
  
Certification Emblematic Merchandise 
We are pleased to announce new certification emblematic merchandise is now available to purchase through the IAAP 
Bookstore.  There are CPS, CAP, and CPS/CAP paperweights; CPS, CAP, and CPS/CAP desktop business card holders; 
and jeweled CPS and CAP pins (these do not replace the official pins provided by International when an individual attains 
the CPS or CAP rating). 
 
*New candidates apply to take either the three-part CPS exam or the four-part CAP exam and must take all parts on their 
first attempt; CPS exam candidates will take three parts – CAP exam candidates will take four parts.  CAP candidates do 
not receive the CPS rating upon passing Parts 1-3 of the CAP exam. 
  
**Individuals with an active CPS rating may apply to take Part 4 only of the CAP exam. 
 
New candidates will find the Certification Application Packet at http://www.iaap-hq.org/prodev/certification/
CertAppPacket.pdf. 
 
2009 Certification Conference 
Registration for the 2009 Certification Conference, Sharp Skills for Tough Times, will open June 1 for those with an active 
CPS or CAP rating.  Space permitting, regular registration for those not certified will open August 1.  
  

Location:  Portland OR 
Hotel: Portland Marriott Downtown Waterfront 
Room Rate: $189 single or double plus applicable taxes 
Registration Fees: Early Bird – June 1-July 31 (active CPS and CAP holders only) 
 $525 IAAP members / $605 nonmembers 
  
 Regular Registration – August 1-September 21 
 $615 IAAP members / $725 nonmembers 

  
Watch for additional details and registration here. 
  
Recertification 
Remember to share with CPS and CAP holders the changes to the recertification program effective January 1, 2009. 

Categories from which to earn the required 90 points: 
Education – up to 90 hours; a minimum of 30 hours is required 
Experience – a maximum of 30 points 
Leadership – a maximum of 30 points 
Elective – a maximum of 30 points 

  
Changes in accepting recertification packets and fees: 
Effective January 1, 2009, those CPS and CAP holders who do not recertify by their time limit may have a 120-day grace 
period to submit their complete recertification paperwork. Those individuals will pay the initial $75 recertification fee plus a 
$100 late fee.  All recertification points need to be earned within the original five year time limit, and if approved, 
recertification will be back-dated to that time.  This new process is not retroactive. 
  
To assist members and guests to attain these needed points, make sure to work with your program chairman to request 
recertification points for your chapter and division educational programs.  The educational programs must be at least one-
hour in length and must cover topics relevant to the exam outline; (business meetings are not eligible for recertification 
points). 
  
Details on requesting recertification points for chapter and division educational programs can be found here. Please submit 
the request to certification@iaap-hq.org at least two (2) weeks prior to the program.  Programs cannot be approved after the 
fact.   All program requests received at certification@iaap-hq.org are acknowledged within 24 hours (unless received on the 
weekend).  If you do not receive that e-mail confirmation, please send a follow-up message.   

C E R T I F I C A T I O N  U P DA T E  (08 /09  #4 )  
A publication for Chapter and Division Certification Chairs 

(with courtesy copy sent to Chapter and Division Presidents and President-Elects) 

                                                                                                                                                                                                   July 2009 

http://www.iaap-hq.org/prodev/certification/CertAppPacket.pdf�
http://www.iaap-hq.org/prodev/certification/CertAppPacket.pdf�
http://www.iaap-hq.org/prodev/certification/CertAppPacket.pdf�
http://www.iaap-hq.org/prodev/certification/CertAppPacket.pdf�
http://www.iaap-hq.org/events/certification/index.html�
http://www.iaap-hq.org/prodev/certification/recertificationedprograms.html�
mailto:certification@iaap-hq.org�
mailto:certification@iaap-hq.org�


-13- 

 

August 2009 

More Certification Benefits for You…. 
 

FOLLOWING IS INFORMATION REGARDING THOSE ATTENDING OR 
THINKING OF ATTENDING JOHNSON COUNTY COMMUNITY COLLEGE 
FOR HIGHER EDUCATION. IF YOU HAVE RECEIVED YOUR CPS AND/OR 

CAP DESIGNATION, JCCC WILL GRANT CREDIT TOWARDS YOUR 
DEGREE DEPENDING ON WHICH DESIGNATION YOU HAVE. 

JOHNSON COUNTY COMMUNITY COLLEGE 
 

COLLEGE CREDIT FOR THE 
IAAP (International Association of Administrative Professionals) 

CPS (Certified Professional Secretary) and/or 
CAP (Certified Administrative Professional)  

 

JCCC will grant 21 hours of non-traditional credit for the successful completion 
of the IAAP CPS and/or CAP examinations prior to 2004. To apply, please 
contact the Prior Learning Assessment advisor in Testing Services located on the 
third floor of the Student Center. Tel: 913-469-8500, Ext. 3538. 

Certifications Taken Before 2004 

Part I: Finance and Business Law 
ACCT 111 Small Business Accounting 3 credit hours 
LAW 121 Introduction to Law 3 credit hours 
ECON 132 Survey of Economics 
or 
ECON 230  Economics I 3 credit hours 
 

Part II: Office Systems and Administration 
BUS 121 Introduction to Business 3 credit hours 
BOT 130 Office Systems Concepts 3 credit hours 
 

Part III: Management 
BUS 140 Principles of Supervision  
or 
BUS 141 Principles of Management 3 credit hours 
BUS 225 Human Relations 3 credit hours 
 

TOTAL CREDIT HOURS 21 credit hours 

Certifications Taken in 2004 to Present Year 

Exam Section: Office Administration  
BOT 130 Office Systems Concepts 3 credit hours 
BOT 150 Records Management 3 credit hours 
BUS 150 Business Communications 3 credit hours 
 

Exam Section: Management 
BUS 140 Principles of Supervision  
or 
BUS 141 Principles of Management 3 credit hours 
BUS 243 Human Resource Management 3 credit hours 
 

TOTAL CREDIT HOURS 15 credit hours 
To qualify for these credits, you need to submit a copy of your IAAP CPS 
certificate and transcript showing grade results. The non-traditional credits will 
be recorded on your permanent transcript after you have completed 6 hours of 
credit course work in residence at JCCC. The cost for certificate evaluation is 
$25 per credit hour. Revised: May 2007 

CPS/CAP Study Group:  Informal study group to prepare for CPS/CAP every Thursday evening at 5:30 p.m. 
held at Sprint. 
For more information contact: Patty Steck patty.steck@sprint.com 

EXAM FEES 
Effective with the November 2009 exams 

CERTIFICATION CPS/CAP EXAMS 

Future Exam Dates  
and Deadlines 

 
Following are the dates and deadlines for 
future CPS and CAP exam administrations: 

IAAP Members 
(no change in fees) 

CPS Exam 

$50 processing fee 

$160 registration fee, all three parts * 

$60 registration fee, per retake part 

CAP Exam 

$50 processing fee 

$210 registration fee, all four parts * 

$60 per retake part 

$120 Part 4 only (active CPS holders only) ** 

Non-Members 
(new fees) 

CPS Exam 

$85 processing fee 

$250 registration fee, all three parts * 

$100 registration fee, per retake part 

CAP Exam 

$85 processing fee 

$300 registration fee, all four parts * 

$100 per retake part 

$160 Part 4 only (active CPS holders only) ** 

Exam Dates Deadline Dates 

Nov.6-7, 2009 Aug. 15, 2009 

May 7-8, 2010 Feb. 15, 2010 

Nov. 5-6, 2010 Aug. 15, 2010 
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Sun Mon Tue Wed Thu Fri Sat 
   1 2 3 4 

5 6 
 

7 
 

8 9 10 11 

12 
 

13 14 15 16 
CPS/CAP Study 
Group 

17 18 
 

19 
 

20 
 

21 
Chapter Board 
Meeting 
 

22 23 
 

24 25 

26 
International 
EFAM 

27 
International 
EFAM 

28 
International 
EFAM 

29 
International 
EFAM 

30 
CPS/CAP Study 
Group 

31  

For questions or comments about the Analecta newsletter, or to submit an article for the next issue, contact 
Carol Zamaitis at carolz1955@yahoo.com. 

 

 

 

 

 The 2009 International Convention and Education Forum will be held July 26-29 
at the Minneapolis Convention Center, Minneapolis, Minnesota. 

 The 2009 Certification Conference will be held at the Marriott Hotel, Portland, Oregon, 
October 18-21. 

 
For subscription and e-mail address changes to OfficePro Express ENewsletter, send an e-mail to 

membership@iaap-hq.org. To contact the editor, send an e-mail to aensminger@iaap-hq.org. 

Ju
ly

 2
0

0
9

 

IMPORTANT REMINDERS:   
 
 Renew Your IAAP Membership on time and avoid the $15.00 late fee! 
 
 Bring items for SAFEHOME and TLC to each meeting. If we all bring one item 

to each meeting, think of the difference we can make! 
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